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Nevada DOT utilizes AASHTOWare Project™

As most of you are aware, the DOT has teamed up with the American Association of State Highway
and Transportation Officials (AASHTO) and is now requiring ALL prime and subcontractors working on
DOT projects with federal funding to submit certified payrolls into the AASHTOWare Project Civil
Rights and Labor™ (CRL) Management System.

You can create this spreadsheet with MOST of the data filled in by Certified Payroll Solution;
however, there is NO WAY to provide this as a 100% accurate form that can be submitted due to
complicated requirements - including several drop-down menu items - that we cannot complete,
these items will be highlighted later in this document. You will need to check this form carefully
before submitting it.

The spreadsheet is provided by the vendor who developed the AASHTO Trns*port® system and many
aspects of it cannot be changed or modified. This form has been provided in an .XLSX format,
therefore, Office/Excel 2016, Office 365 or newer is required - and they must be locally installed on
your computer, not accessed via a web browser.

The most important thing that you need to be aware of is that this spreadsheet CANNOT be
printed by CPS, nor will the print preview be visible to the human eye.

DO NOT call and tell us that the Preview of the report is wrong, as there is NOTHING, we
can do about this.

However, you MUST click the preview button on the Print Window in CPS to create the
Excel spreadsheet for you so that you can then open it and look at it and verify that the
data is accurate and add any missing information that is required.

AASHTO requirements are very complex and require quite a bit of setup in Certified Payroll
Solution in order to create a file that you can read, correct, and troubleshoot to upload -
AND THEN YOU WILL NEED TO TAKE THAT FILE CPS CREATED AND RUN IT THROUGH A
CONVERTER to create a machine-readable XML file - so please follow the instructions in
this document carefully. The AASHTO specific converter can be found here -
https://xml.aashtowareproject.org/spreadsheet/

Step 1 - Download the program update

You MUST update CPS on each machine that the program is installed on.

The version that you download will be the most CURRENT version in our Web Service Center (5.0.950
is the INITIAL release of this update and it will be included in higher versions - 5.0.951, 5.0.952, etc.)

To download the update, in CPS go to the Help menu - Check for Updates (or Help > About - Login
to Web Service Center).
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This launches a web page and automatically logs you into our web service center. Here, look for the
Download Current CPS Setup/Installation button on the left and click on it. Run or save the file.

SunbursaSQIRtEerre=Soltions

Welcome to our Web Service Center

Certified Payroll Solution

|:] is the current release version available to download.

: is the current version installed on your PC. Download the

You have installed a newer or BETA version that the current rel CURRENT CPS rent release

version over a BETA/older version can cause problems. Do noft i AUSIELELEIRN - t5 do so
by technical support.

Windows 7,8,8.1,10 users

Download Current CPS Setup / Installation (Windows 7,8,8.1,10)

Some browsers will have you save the file, while others will allow you to choose to Run

it. If you choose the Run option, simply follow the prompts, and run through the
installation program.

~

u
Can’t figure out where the download was saved?

g™y Press the Ctrl and the J keys at the same time on your keyboard to display a list of

- things you have downloaded. This works in Internet Explorer, Chrome, and Firefox.

Double-click the file called CPSV5setup.exe and follow the prompts in the installation
wizard.

If for some reason you have trouble installing the update, you may need to:
e Turn off your anti-virus
e Check your firewall settings

e Or, if you have an IT company, they may have prevented you from installing software - so
call them first - as they may need to do it for you.

Step 2 - Make sure you have a Saved Reports Folder
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Because the AASHTOWare Project™ Payroll form is an actual spreadsheet, it is saved in your Saved
Reports folder.

If you do not have a View menu option in CPS, you’ll need to create and select a folder in which to
save this.

€& Nevada Certified Payroll Solution for QuickBooks Certified Payroll Solution by SunburstS...  — O X

Run Linked Data BasicInfo Backup and Restore System Setup |View [Help

From the CPS System Setup menu - choose System Preferences - click on the Data Locations tab

Click into the Save Report Folder field/box and press the F9 key to have the program automatically
create a folder for you - if this field is currently blank/empty.

OR use the Browse for Reports Folder to create a folder in the location of your choice.

(Press the F5 Key to verify that the folder actually exists)

Addresses | W/ClInfo+ | Labels = Settings Data Locations

Data Path Browse for Data Path Folder

(

The "Data Path" is the folder that contains the “Data" folder where all CPS files exist.

Quick Books File Browse for QuickBooks File

The best way to set your QuickBooks file to the correct location' is to make the box here blank, and then have
QuickBooks open to the correct file and click the 'Test QuickBooks Connection'.

Test QuickBooks Connection [~ QuickBooks Version is 2004 or older.

Save Reports Folder Browse for Reports Folder

Click here & press the F9 key to have one automatically created for you

Electronic Upload Folder Browse for Electronic Upload Folder

Step 3 - Setup Fringe Benefits & Special Withholdings
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AASHTO allows for up to 18 different entries in the top benefits section - for the time being we are
sticking with the 6 benefits that the AASHTO form seems to require. AASHTO also requires the
hourly rate of each specific fringe benefit types to be displayed as well as the TOTAL Hourly
fringe benefit rate. These benefits can be paid to the Union Hall, one or more bona-fide plans, or
company paid items that you are taking credit for against the full fringe - this is totally different
than how any of the current form requirements have always been.

These hourly rates/values will need to be entered into CPS, because we cannot get hourly values
from QuickBooks only Weekly totals.

Important notes & information about fringe benefit setup.

-

Read the following information prior to making any selections in this section.

In CPS, you can enter the Hourly Fringe Benefit Rates by:

e Work Classification
e Payroll Wage Item
e Employee

Please determine HOW you are paying and tracking the fringe benefits for assistance with proper
setup.

1. If you are a Union Contractor OR paying 100% of the full fringe benefit rate to one or more
bona-fide plans, you can choose from one of the following options:

a. Select This fringe is paid by the employer AND This amount is calculated by
Certified Payroll Solution using the rate entered for each payroll wage item. You
must then have specific payroll wage items in QuickBooks that you use for specific
Work Classifications OR Work Classifications and Jobs (if the fringe rate changes by
job). You will then enter the hourly fringe amounts for each type of fringe benefit by
going to the Linked Data menu - Wages and editing each payroll wage item and enter
the correct hourly fringe rate.

b. Select This fringe is paid by the employer AND This amount is calculated by
Certified Payroll Solution AND This contribution rate is entered for each Work
Classification. This method will work if you DO NOT have specific payroll wage items
in QuickBooks that you use for specific work classification and jobs. You will then
enter the hourly fringe amounts for each type of fringe benefit by going to the Basic
Info menu - selecting Work Classifications - edit each Work Classification and enter
the hourly values in the Benefits tab.

2. If you are a non-union contractor and pay 100% of the full fringe amount in CASH to the
employee select This fringe is paid by the employer AND NO calculation. You will then
enter the full hourly CASH fringe rate by going to the Linked Data menu - choose Wages ->
edit each payroll wage item and enter the full fringe amount in the Cash Benefit Rate box.
This method assumes that you have specific payroll wage items for specific work
classifications and/or Jobs.

3. If you are a non-union contractor and pay a portion of the hourly fringe rate to a bona-fide
plan AND the remainder in cash to the employee, select This fringe is paid by the employer
AND This amount is calculated by Certified Payroll Solution. Next go to System Setup menu
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- choose System Preferences - click on the W/C Info + tab - check the box to Enter Fringe
Benefits by Employee. Then go to the Linked Data menu - Employees - edit each employee
and enter the hourly values that you pay in the Benefits tab. You will then enter the full
hourly fringe rate by going to the Linked Data menu - choose Wages - edit each payroll
wage item and enter the full fringe amount in the Cash Benefit Rate box.

In CPS, go to the System Setup menu - choose Fringe Benefits & Special Withholdings to indicate
HOW you pay these fringe benefits.

. . | —
The fringe benefit types R
a re : | H &W Bene Pension Bene | Vacation Bene App Tr. Bene Other Bene | Vac Deduction H & W Deduction Other Bene #2
e Health & Welfare Name:  [GtherBene#2 ™ Highly recommended that you NOT change this name. ’
Benefit
. . Paid by Employee or Employer:
[ ] PenSlon Benef]t & This fringe is paid by the employer N EW
° Vac a t -i on Be n efi t " This is deducted from the employee's paycheck
e Apprentice Training S
Be n efl t " This amount is derived from the QuickBooks paycheck.
) Ot he r Ben ef'i t | & This amount is calculated by Certified Payroll Solution using the rate entered for each Payroll Wage Item.
. | € No calculation
e Other Benefit #2 |
(new)

And then, there are the:
e Vacation Deduction

e Health & Welfare - Concel (%)

Deduction

Make your selection for each specific fringe benefit item here and then go to the appropriate place
to enter the hourly values.

Step 4 - Setting up Fringe Benefit Information
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Near the top of the form (between your information and the employee information) there is a Fringe
Benefit grid, which requires you to report the following information about each Fringe Benefit that

you pay:

e Benefit Program Name - this would be the name of the Union, Health Insurance Plan name,
Pension Plan name, etc.

e Benefit Program Type - whether this is a Health & Welfare benefit, a Vacation/Holiday
Benefit, an Apprenticeship Training Benefit, a Pension Benefit, or an Other #1 or Other #2
Benefit.

e Benefit Account Number - your company’s account number with the Benefit Program Name

e Benefit Labor Classification - we are assuming that this would be the labor/work classification
that this specific benefit would be paid for (so equipment operators, laborers, etc.)

¢ Contact Person - the name of the Contact Person at the Benefit Program Name

e Contact Person’s Phone - the phone number of the Contact Person

Below is a screenshot of the area I’'m talking about.

Benefit Program Name Benefit Program Type. [ Benefit Account Number Benefit Labor Classification Contact Person Contact Perzon's Phone
Select Tupe v
Seleot Type

Select Type
Seleot Type
Seleot Type
Select Type
Select Type
Select Type
Select Type
Seleot Type
Seleot Type
Select Type

Seleot Type
Select Type
Seleot Type
Select Type
Select Type
Select Type

This grid can be completed by completing additional information within CPS, by going to System
Setup - Statement of Compliance.

Clicking on the DOT 4 (d) tab allows you to enter the Labor/Program Classification information (|
opted to type in All Work Classifications - indicating that all Work Classifications received a Health
Fringe). Typing an X in the Specific type of Fringe Benefit column will automatically select AASHTO’s
wording. In the example below | placed an X in the Health column, and it displays as Fringe Health
Welfare in the Benefit Labor Classification column of the table.

Benefit Program Type Benefit Account Number | Benefit Labor Classification

All Work Classifications

Fringe Health/Welfare 123456

@ Statement Of Compliance (WH-348 - Oa X =
WH-348(1) | WH-348(4) | DOT4(d) | D e
SHTO DOT 4 (d) E

Labor/Program Classification Vacation | Training Pension Other Other 2
All'Work Classifications ® ‘ &
| 3
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Next, you’ll click on the DOT 4 (e) tab.

Here you’ll enter:

Page 7

¢ Program Name (who the fringe is paid to) = Benefit Program Name
e Account Number (your account number with who the fringe money is paid to) = Benefit

Account Number

e 3" Party Trustee/Contact - a contact person where the money is paid to) = Contact
e Phone (Number) - of the Contact person = Contact Persons Phone

Benefit Program Name. Benefit Program Type

Benefit Account Number

Benefit Labor Classification

Contact Person

Contact Person's Phone

Union Local 20

Fringe Health/Weifare

123456 All Work Classifications

Shirley Somebody

8005622520

{3 Statement Of Compliance (WH-348

= [u]

one
Shirley Somebody |(800) 562-2520
[

T T

If, for example, you pay all of the fringes to a specific Union, 4 (d) would look like this

€X Statement Of Compliance (WH-348 O X
WH-348(1) | WH-348(4) | DOT 4(d) | DOT 4(e)
AASHTO DOT 4 (d)
Labor/Program Classification Health Vacation Training Pension Other Other 2
All'Work Classifications %
All'Work Classifications %
All'Work Classifications ®
All'Work Classifications %
All'work Classifications ®
All'work Classifications o
And DOT 4 (e) would look like this
€3 Statement Of Compliance (WH-348 O X
WH-348(1)  WH-348(4) DOT4(d) | DOT 4 (g \
AASHTO DOT 4 (e)
Program Name Account # 3rd Party Trustee/Contact  |Phone
Union Local 20 123456 Shirley Somebody (800) 562-2520
Union Local 20 123456 Shirley Somebody (800) 562-2520
Union Local 20 123456 Shirley Somebody (800) 562-2520
Union Local 20 123456 Shirley Somebody (800) 562-2520
Union Local 20 123456 Shirley Somebody (800) 562-2520
Union Local 24 123456 Shirley Somebody (800) 562-2520
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Step 5 - Setup AASHTO Ethnicity Codes in CPS

AASHTO and EACH State’s DOT have agreed upon specific Ethnicity (Race) Codes. These codes are
totally different than those that we provide for regular (printed) EEOC Reports.

Ethnicity Values Code
Select Ethnicity

ASIAN INDIAN A-IN
ASIAN/PACIFIC ISLANDER A-PF
SUBCONT. ASIAN AMERICAN AS-AM
ASIAN-PACIFIC AMERICAN AS-P
BLACK AMERICAN BLK
CAUCASIAN CAUC
HISPANIC AMERICAN HISP
HANDICAPPED HNDC
NATIVE AMERICAN N-AM
NON-MINORITY WOMEN NMWM
NOT SPECIFIED NS

From the Basic Info menu = Race
Classifications -> click the Add
button

In the Description block, type in
HANDICAPPED

From the Race drop-down menu ->
choose a “normal” race.

NOTE: As long as HANDICAPPED
appears in the “name field” it will
populate correctly with HNDC on
the final report.

Click Ok, Done and choose Yes to
save changes.

This is a list of Ethnicity Codes that DOT
has chosen, and you will need to Add or
Modify these in CPS by going to the Basic
Info menu 2> Race Classifications

These classifications must be set up
EXACTLY as they are shown to the right.

Below is an example for adding the
HANDICAPPED classification.

€¥ Race Classification Maintenance - O X

Alaskian
American Indian
Asian

Black

Hispanic

Pacific Islander

White

Description |HANDICAPPED

Race

e 3

[~ Minority
[~ Native Hawaiian or Other Pacific |slander

[~ Two Or More Races

Ok | Cancel
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Here is how we are dealing with the other Ethnicity Values:

If "Handicap” is in the Race Classification description (case insensitive) then Handicapped
(HNDC) is used.

If "Not Specified” is in the Race Classification description (case insensitive) then Not Specified
(NS) is used.

Native American, Black, and Hispanic are determined by the race drop down list and reported
as (N-AM), (BLK), and (HISP).

White men are listed as Caucasian (CAUC)

White women are selected as Non-Minority Women (NMWM)

If "Asian/Pacific Islander” is selected from the Race drop down list, then (A-PF) is reported

If the race check box for "Native Hawaiian or Pacific Islander”, the "Asian-Pacific American” is
reported (A-PF)

If the race class name contains "India" (case insensitive) American Indian is reported (N-AM).
If the race class name contains "Pacific" (case insensitive) American/Pacific Islander is
reported (A-PF).

All other Asians are classified as Subcont. Asian American and reported as (AS-AM).

Yes, it’s a lot to deal with.

You will want to go to Linked Data menu - Employees and Edit each employee making certain
that their Race/Ethnicity has been setup correctly.
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Sunburst Software Solutions, Inc.

Page 10

Step 6 - Setup Craft & Labor Codes in CPS

AASHTO also allows each state to specify their own specific Craft & Labor Codes.

Nevada has chosen 21 Craft Codes and 1,552 Labor Codes! So, you’re in for some fun.

The Craft & Labor Code lists can be found within the actual Payroll Form spreadsheet you were
provided with - if you don’t have handy access to that spreadsheet, you can use the template that

we provide after you do a trial run.

To enter the Craft & Labor Codes specific to your company, in CPS, go to Basic Info 2 Work
Classifications = . Here you will either Edit existing Work Classifications OR Add new ones based on

AASHTO requirements.

These codes are entered on the Electronic Upload Codes tab and the Craft & Labor Codes must
be entered into CPS EXACTLY as they are shown in the AASHTO spreadsheet - including the use
of ALL CAPS and some things being in (parenthesis).

Here’s an example: Let’s say your company has workers that fall under the Truck Driver Group 1

Zone 1 Craft Code:

e The AASHTO Craft Code would be Truck Driver
e The AASHTO Labor Code would be Truck Driver Group 1 Zone 1

€& Work Class Maintenance

Zone
Federal EEOC Code
Use This Name on EEOC Reports

On the Job Trainee -

Apprentice

On the Certified Payroll Report

Texas DOT Job Class
NY DOT EBO Classification Code
Manland Classifi

ion I0 Lloh Code 10 [

Name | Truck Driver Group 1 Zone 1

= [m] X
[_
|Txuck Drivers LI
-
Owner Operator -
[T Percent 0 Level

i TX DOT Appr Experience 0
,_

AASHTO Craft Code
AASHTO Labor Code

|Truck Driver

ITuuck Driver Group 1 Zone 1

Prism Craft
Prism Craft Level

LCPtracker Craft Code

Ok Cancel

I
[
|
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For existing users - If
you create new Work
Classifications
remember that you will
need to assign them to
Employees (Linked Data
- Employees) and
QuickBooks Payroll
Wage Items (Linked
Data > Wages).

For new users - you
will assign these Work
Classifications to
Employees and Wages
as you set the program

up.
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Step 7 - Selecting Jobs that require AASHTO Reporting

In CPS, go to Linked Data 2> Jobs = Edit each job that requires AASHTO reporting.
On the Additional Info tab:

e we are using your MPA# as the Contractor ID
e and we are using the PWP as the Contract #

€¥ Job Maintenance o O

07-176 Name [15-271

Standard Information Additional Information Form Options
MPA # [NV Contractors License #
PwWP |Used for A4SHTO Contract #

This may or may not be correct, there was little direction for us to complete the form. If these
should be wrong, contact us as AskUs@SunburstSoftwareSolutions.com and tell us what really should

be in these fields.

Switch to the Form Options tab, click the Form to Use drop-down menu & select AASHTO
Trans*Port Spreadsheet

Q Job Maintenance

Name j15-2711

Standard Information Additional Information

Form Options

NOTE: We are not
certain of how the
Employee Social
Security # format is
to be displayed.

Certified Payroll Report
Form to Use SASHTO Trans*Port Spreadshee v

[~ Use Department of Defer Nevada State Form

. WH-347 Federal Form
[~ Use Notarized Federal St Nevada DOT Form

‘Washoe Schools Form
AASHTO Trans*Port Spreadsheet
7 If a save reports folder is specified, do not physically print this form (CPR & SOC), just save it.

™ List By "Print Name As"
2

SSN # Format Show SSN |

[~ Omit Employee's address.

Electronic Filing

Electronic Upload Type INone

SSN # Format IShow SSN

[~ Omit Employee's address.

0Ok Cancel
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Step 8 - Printing & Previewing

When you get to the Completed Reconciliation window, you MUST Preview the Certified Payroll
Report for CPS to create the AASHTO file for you. DO NOT attempt to Print it.

€3 Completed Reconciliation = O X

Copies for Each Report

SetAll Copies to: | |1 SelectPrinter: | cs2417en

" Redact employee SSN & address information on Certified Payroll Report
[~ Force all printing to Legal Size Paper

Preview Certified Payroll Only — Does NOT include the Statement of Complidhce

<< Back Print Mailing Labels Complete 0
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XY CPRSxlsx v

File Print Preview

Eg] [a=] CD\ NextPage

Zoom -

Zoom Preview

X
Close Print
Preview

L N
g o]

Preview: Page 1 of 6
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When you click the Preview Certified
Payroll Only - Does NOT include the
Statement of Compliance button you
will see something like this.

This is the way it was designed to
preview and there is nothing we or you
can do about it.

Simply click the Close Print Preview
button.

When you have finished in CPS, click the
Complete button.
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Step 9 - Viewing, Troubleshooting, Converting & Uploading

From the main CPS window, choose the View menu - Saved Reports
This will automatically open the folder that you created in Step 2.

Here you can double-click on the Job name to open it in Excel, in a manner that you can actually
read it, to verify it for accuracy.
EErX I )

“ Home Share View
}? u 4 Cut x ‘ E'TjNewntem' ﬂ Open BHSeledall

w- Copy path = EJ Easy access Edit Select none

| Pin to Quick Copy Paste Move Copy Delete Rename New Properties o

access [7] Paste shortcut o s - folder = @ History - Invert selection

Clipboard Organize New Open Select
<« v A « Users > Public > CPSMasters > Nevada > Saved Reports v 0 Search Saved Reports
o) Name Double-C“Ck to operbate modified Type Size
s Quick access ‘
@ CPR-15-271 (QB JOB Name)-2000-10-07.xlsx 3/2022 4:04 PM Microsoft Excel W... 363 KB

‘ I Desktop *

What you still need to do:

There are 4 drop-down menu items for EACH Employee that we cannot complete, this means that
you’ll have to do this each week.

If you’re viewing the .pdf version of these instructions, they are highlighted in yellow, outlined in
red, with red arrows.

If you’ve printed these instructions, you’ll see them outlined and there are arrows.

O.T. Over Time Hours
Individual Employee Name and Identifier S.T. Standard Time Hours F
S.H. Salaried Time Hours
Last N\ame |Employee
First N\ame |Eight 0.T. 0.00 0.00 0.00
= - Project #
Middle Initial |! S.T. 0.00 0.00 0.00
SSN |123-45-6789 | Default PWP# S.H. 0.00 0.00 0.00
Partial SSN Craft Code Select Craft Code oI %
Vendor Emp ID i Labor Code Select Labor Code i -
Gender [Male Truck Driver |tk Driver Group 1 Zone 1 | |
Ethnicity HNDC Select Ethnicity Salaried Employee Only
AddrLine 1 |123 anywhere street : F |
Total Pay Period Normal Salary Gross Pay FICA Eke
Addr Line 2 Salaried Hours Income Tax
City [anythown 923.39 55.82 | 100.00
State NV Select State Code Fringe Benefit
zio (89101 . i Health A -
L w:;;re Vacation Holiday p‘;'e:;'ce
Has Changed? TRUE g
Salaried (y/n) : No | 0.75 | 1.50 | o025 |
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For additional clarity, the items are Select Ethnicity, Select State Code, Select Craft Code, and
Select Labor Code.

Each of these requires that a real live human, click a drop-down menu and select an option and is
not something that software can do.

We have been able to provide you with some assistance though:

e For Ethnicity - we provide the CODE
e For the State - we provide the NV 2-letter abbreviation (all other AASHTO States use just the
2-letter abbreviation)
e There are empty blue cells in the spreadsheet which we utilize
o to hold the Craft Code Name (Truck Driver) you have to grab the drop-down and menu
and select it.
o And the Labor Code Name (Truck Driver Group 1 Zone 1), but again, you have to grab
the drop-down menu and select it.

ONCE YOU HAVE VERIFIED THE INFORMATION IS CORRECT YOU WILL NEED TO TAKE THE EXCEL
FILE AND CONVERT IT TO THE XML FORMAT THAT THE AASHTO SYSTEM CAN READ!

The converter can be found here - https://xml.aashtowareproject.org/spreadsheet/

Once you have opened this web page - follow the Contractor Instructions indicated below in the
screenshot:

Contractor Instructions
= Please contact your agency to request a copy of their customized Payroll Spreadsheet.

= Completed Payroll spreadsheets can be used with the Conversion Utility below.

= If you experience issues with using the AASHTOWare Project Spreadsheet and Conversion Utility, please contact your agency's representative.

Converter
Once you have a payroll spreadsheet with your data entered, you can create a Payroll XML file online with this tool.

Instructions:
= Use the following form to select the spreadsheet you have created, Check the box agreeing to the Terms of Use, then click the Convert button to send your

dsheet to the onli i ili \
spreadsheet to the ome ﬂ/e@nw
Browse... ‘“e selected. ‘ | agree to the Terms of Use | Convert
= Save the Payroll XML file that is returned from the online converter.
You can now deliver the Payroll XML file to the agency via whatever method they have established.

Using the BROWSE button navigate to and select the Excel file you verified.
Click the “I agree to the Terms of Use” option
Click Convert

Once it’s converted, save the NEW XML file back to your hard drive in the same location.

Log into the DOT website and select the xml file to upload the report.
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